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Using the SiRFdemo Software

The SiRFdemo software is provided to simplify real-time monitoring of the Evaluation Receiver,
configuration of the Evaluation Receiver, and efficient logging of data in the field for further
analysis.

Before running the software, you need to attach the Evaluation Receiver to your PC, which
must be connected to a power source. You should also have an antenna on the Evaluation
Receiver and position it so the antenna has a clear view of the sky.

To start the SiRFdemo software, either double-click on the sirfdemo.exe file or, if you
created a short-cut on your desktop, double-click the SiRFdemo icon.
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1 SiRFdemo Menus

The SiRFdemo software has six menus, which are described in table 4-1.

table 4-1 SiRFdemo Menus

Menu Description

Setup The Setup menu lets you configure the data source used by SiRFdemo and
configure operating preferences. See "The Setup Menu" on page 6 for
detailed information about the Setup menu.

View The View menu lets you display different view windows. The available view
windows include:

• Signal Level
• Tracking
• Map
• Navigation
• Response
• Error
• Development
• DGPS Status

See "The View Menu" on page 10 for detailed information about the View
menu.

Action The Action menu provides access to most of the SiRFdemo functionality
including configuration of the Evaluation Receiver and data logging for later
analysis. See "The Action Menu" on page 20 for detailed information about
the Action menu.

Navigation The Navigation menu lets you configure items that effect how a position
solution is acquired or the type of position needed.
FROM the Navigation menu, you can set various operating masks, the
DGPS mode, and the DGPS source. See "The Navigation Menu" on page
39 for detailed information about the Navigation menu.

Poll The Poll menu is used to obtain Evaluation Receiver information such as
software version, navigation parameters, and clock status. You can also use
the Poll menu to obtain the latest ephemeris and almanac. See "The Poll
Menu" on page 47 for detailed information about the Poll menu.

Window The commands on the Window menu control the appearance of the
information displayed. For detailed information about the Window menu, see
"Changing Preferences" on page 9.

Note - The values that appear in the dialog boxes are Evaluation Receiver default
values and not what is currently set in the Evaluation Receiver. See "The Navigation
Parameters" on page 49 to determine the current settings of all navigation
parameters.
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2 The Setup Menu

This section describes the SiRFdemo functions on the Setup menu:

• "Selecting the Target Evaluation Receiver" on page 6

• "Defining the Data Source" on page 7

• "Changing Preferences" on page 9

• "Displaying Information About the SiRFdemo Software" on page 10

• "To Exit the SiRFdemo Software" on page 10

- Data Source

2.1 Selecting the Target Evaluation Receiver

The SiRFdemo software supports the SiRF product lines, SiRFstarI/LX, SiRFstarIIe, and
SiRFstarIIe/LP. A built-in auto-detection feature allows the SiRFdemo to identify the
hardware/software platform it is connected to and configure the pull down menus correctly.
This provides access to features that are common to both platforms (i.e., protocol) and
individual access and definition to features that are either unique (i.e., Static Navigation) or
redefined (i.e., TricklePower) for each platform.

Once connected, the SiRFdemo software attempts to identify the system as either SiRFstarI
or SiRFstarII. If the hardware detection function fails, you are prompted to select the
hardware platform manually. The auto-detection function can be disabled by unchecking the
Auto-Detection check box.
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To select the target Evaluation Receiver:

1. Choose Receiver S/W... from the Setup menu.

The Selection of Target Receiver Software screen is displayed.

2. Click the appropriate hardware platform button ÿ SiRFStarI or SiRFStarII.

If you are using a SiRFstarII product, you must also select the software version being
used - either 2.0.x or 2.1 or higher.

3. Uncheck the Auto-Detection checkbox if you want to disable the auto-detection
function.

2.2 Defining the Data Source

The SiRFdemo software is capable of receiving data from different sources. You can
configure the demo to receive data directly from a connected Evaluation Receiver, generate
its own random data, or load data from a previously logged file.

To configure the source of the data used by the SiRFdemo software:

1. Click the Data Source button or choose Data Source from the Setup menu.

The Data Source Setup screen is displayed.
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2. Select either the Supplied Data or Random option:

Option Description

Random Uses randomly generated data. Use this option to verify that the
SiRFdemo software is running without the Evaluation Receiver
connected.

Supplied Data The SiRFdemo software will use real data either directly from a
Evaluation Receiver, or from a file. If a file is used, the original data
can be in either SiRF Binary or NMEA. However, the file itself must
be a binary file.

3. To use data from a file, select the File radio button and select the appropriate file using
the Browse button.

Note - The Simulator (Truth Data) option is not yet implemented.
Do not use the File radio button. This option is not implemented at this time.

4. To use data directly from an Evaluation Receiver, select the Serial Port radio button.
Use the selection lists to choose the serial port to which the Evaluation Receiver is
connected on your PC, and the correct baud rate.

5. Click the OK button to continue.
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2.3 Changing Preferences

You can change the appearance of some of the view windows to suit your personal
preferences. View preferences include the Signal Level view, the Tracking view, and the
Map view.

To change the appearance of the view windows:

1. Choose Preferences from the Setup menu.

The Preferences screen is displayed.

2. Select the type of signal graph that you want to view on the 12-Channel Signal Level
View screen:

Option Description

Bar Displays the data with vertical bars to represent the observed signal
strength of each satellite.

Line Displays the data in a continuous line graph form.

3. Select the direction of the tracking orientation that you want to use in the Tracking View
screen:

Option Description

North Up True north points to the top of the circle.

Heading Up This is typically used when driving in a vehicle or if the receiver is
moving. Current heading points to the top of the circle.

4. To change the scale of the Map view, type the number of meters you want each pixel to
represent in the Meters Per Pixel field.

5. Click the Centered Position check box if you want to display the Map View with the
current position at the map center.

6. Click the Save button to save the changes or Cancel to exit without saving changes.
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2.4 Displaying Information About the SiRFdemo Software

1. Select About SiRFstar Demo from the Setup menu to display SiRFdemo software
information:

2.5 To Exit the SiRFdemo Software

1. Select Exit from the Setup pulldown menu.

This closes SiRFdemo software.

3 The View Menu

This section describes the SiRFdemo functions on the View menu:

• "The 12-Channel Signal Level View Screen" on page 11

• "The Tracking View Screen" on page 13

• "The Map View Screen" on page 14

• "The Measured Navigation Message View Screen" on page 16

• "The Response View Screen" on page 17

• "The Error Message View Screen" on page 18

• "The Development Data View Screen" on page 18

• "The DGPS Status View Screen" on page 18

� Signal level

� Tracking

� Map
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3.1 The 12-Channel Signal Level View Screen

The 12-Channel Signal Level View screen is a combined graphical and text display of
satellite tracking. Information shown by the Signal Level view includes the satellite number,
status, azimuth, elevation, C/No, and last five seconds of measured signal strength.

To display the 12-Channel Signal Level view screen:

1. Click the Signal Level View button or choose Signal Level from the View menu.

Note - If you double-click on the 12-Channel Signal Level View screen, the
Preferences screen is displayed. The Preferences screen enables you to modify the
way information is displayed on the screen.

table 4-2 12-Channel Signal Level View Information

Information Displayed Description

Satellite Number (SV) The GPS satellite PRN number.

Status (St) The status of each satellite tracked (see table 4-3, "Tracking
Status Definitions.," on page 12 for more information).

Azimuth (Az) Satellite azimuth (in degrees).

Elevation (El) Satellite elevation (in degrees) with the horizon being zero
degrees in elevation, and directly over-head being ninety
degrees.

C/No Signal level (in dB-Hz).

Signal Level (-5 sec) 5-second history of the measured signal strength.

Table 4-3 represents each of the possible tracking status messages and the corresponding
tracking status. Each tracking status state corresponds with an achieved tracking stage for
each channel of the Evaluation Receiver.
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As an example, if a tracking status of 33 (Hex) is seen, this means that satellite acquisition
has been achieved, the delta-phase is valid, the carrier pull-in is complete, and the code has
been locked onto. From a cold start you will typically see the the following sequence of
tracking status changes; 00ÿ33ÿ37ÿ3FÿBF. It only takes about 1 second to achieve a 37
status, approximately another 12 seconds to get to a 3F status, and finally another 20
seconds to achieve a BF status. The sequence and time frames may vary considerably
between channels and sessions.

table 4-3 Tracking Status Definitions.

Achieved Tracking Stage
Tracking
Status
(Hex)

Acquisition
Success

Delta-
phase
Valid

Bit-sync
Done

Sub-frame
Sync Done

Carrier
Pull-in
Done

Code
Locked

Ephemeris
Data

Available

Acquisition
Failed

00
01 �
03 � �
21 � �
23 � � �
25 � � �
27 � � � �
2D � � � �
33 � � � �
37 � � � � �
3F � � � � � �
8D � � � �
AD � � � � �
AF � � � � � �
BF � � � � � � �
40 �
CC � � � �
CD � � � � �

The information displayed in the Signal Level view is also assisted by color coding. As the
tracking status of each satellite changes, the associated text and signal levels are colored to
represent the current status (see table 4-4).

table 4-4 12-Channel Signal Level View Color Coding

Color Description

Red The satellite location is known from almanac information; however, the
satellite is not currently being tracked.

Blue The satellite is being tracked; however, it is not being used in the current
position solution.

Green The satellite is being tracked and is being used in the current position
solution.
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3.2 The Tracking View Screen

The Tracking View screen graphically displays the location of each of the tracked, used, and
available satellites in the form of a polar plot.

To display the Tracking View screen:

1. Click on the Tracking View button or choose Tracking from the View menu.

In addition to the satellite locations, the current tracking status is represented by color (see
table 4-5).

table 4-5 Tracking View Color Coding

Color Description

Red The satellite location is know from almanac information; however, the
satellite is not currently being tracked.

Blue The satellite is being tracked; however, it is not being used in the current
position solution.

Green The satellite is being tracked and is being used in the current position
solution.

Current speed and heading (in a dynamic environment such as a moving vehicle) is
represented by an arrow. The direction of the arrow represents heading while the length of
the arrow indicates speed over ground.
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Configuring the Tracking View Screen

You can configure the orientation and the velocity representation of the Tracking view
screen.

To configure the Tracking view screen:

1. Double-click the Tracking View screen to display the Tracking View Configuration
screen.

2. Select the direction of the tracking orientation that you want to use.

Option Description

North Up True north points to the top of the circle.

Heading Up This option can be used when driving. Current heading points to the top
of the circle.

3. Type the Outer circle velocity (in m/sec).

Note - The setting of the outer circle velocity means that if the arrow length reaches
the outer circle of the plot, then the outer circle velocity has been reached.

4. Click OK to save the changes or Cancel to exit without saving changes.

3.3 The Map View Screen

The Map view screen displays a combination of graphical and text-based information.
Positions generated by the Evaluation Receiver are plotted on the Map view screen while
other information such as GPS time, GPS week, position mode, current position, heading,
velocity, DOP, type of position fix, and satellites tracked are displayed as text.
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To display the Map view screen:

1. Click the Map View button or choose Map from the View menu.

The Map View screen is displayed.

The current position is represented on the plot by a red dot, while past positions are
displayed in blue.

Note - When using the map view, it may be necessary to edit the origin of the plot. To
edit the origin of the plot, see "To Change the Map View Preferences" on page 15.

To Change the Map View Preferences

The ability to change the scale of the Map view and to select the appropriate .smp file is
provided by the Map view preferences.

To change the Map view preferences:

1. Double-click on the Map View screen to display the Preferences window.
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2. Enter the number of meters you want each pixel to represent in the Meters/Pixel field.
This value controls the map scale.

3. Click the Center Current check box if you want the Map View to be centered.

4. Enter the latitude and longitude (in WGS-84) of the required center of the Map View
display in the Lat and Long fields.

5. To display up to three rings on the MapView display, enter the radius (in meters) of
each of the rings in the Ring Radii group.

If a value of 0 (zero) is entered, the ring will not be displayed.

6. Click the Save button to save the changes or the Cancel button to exit.

3.4 The Measured Navigation Message View Screen

The Measured Navigation Message view screen is used to display position solution
information such as GPS time, GPS week, position mode, current position, heading,
velocity, DOP, type of position fix, and satellites tracked.

To view the Measured Navigation Message View screen:

1. Choose Messages Navigation from the View menu.

The Measured Navigation Message View screen is displayed.

table 4-6 Measured Navigation Message View Information

Information Displayed Description

X, Y, Z positions Coordinates of user's position in ECEF (meters)

Velocity User's velocity in ECEF (m/sec)

Latitude User's latitude (decimal of degrees)

Longitude User's longitude (decimal of degrees)

Altitude User's altitude (meters)

Mode Navigation solution type. This will change from a No Nav
status, through the different fix modes such as 2D, 3DLSQ
etc. The Mode field should be used for any TTFF
measurements.
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table 4-6 Measured Navigation Message View Information

Information Displayed Description

GPS Week GPS week number

DOP Dilution of Precision

Fix Validated/unvalidated. From an unvalidated state, a 5 SV
position solution must be achieved to become a validated
position. If the receiver continues to navigate in a degraded
mode (3D, 2D, 1SV, or DR), then the validated status will
remain. If navigation is lost completely, an unvalidated
status will result.

Time Current GPS time (seconds)

Svs Used in Fix Sv PRN used in solution

Note - ECEF XYZ is converted geodetic latitude, longitude, and altitude based on the
WGS84 ellipsoid parameters.

3.5 The Response View Screen

The Response View screen is used to display any response to a poll request. You can poll
the Evaluation Receiver for the software version (see "The Software Version" on page 48),
clock status (see "The Clock Status" on page 48), and navigation parameters (see "The
Navigation Parameters" on page 49).

To display the Response View screen:

1. Choose Messages Response from the View menu.
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3.6 The Error Message View Screen

The Error Message View screen is used to display any error messages that the Evaluation
Receiver may generate. Error messages are generated automatically by the Evaluation
Receiver under certain conditions. Many are caused by normal GPS operations such as
acquiring a low elevation satellite. This could result in a bad parity.

To view the Error Message View screen:

1. Choose Messages Error from the View menu.

3.7 The Development Data View Screen

The Development Data View screen displays additional information about the Evaluation
Receiver operation. The data is generated automatically by the Evaluation Receiver.

To view the Development Data View screen:

1. Choose Messages | Development from the View menu.

Note - To view incoming development data the Enable Development Data checkbox
must be enabled on the Receiver Initialization screen. See "Initializing the Data
Source" on page 23.

3.8 The DGPS Status View Screen

The SiRFstarIIe/LP Evaluation Receiver has two options for DGPS operation - WAAS or
external RTCM. See "Selecting the DGPS Source" on page 44 for more information about
each of these options. The DGPS Status View screen provides information about the DGPS
source and current operation.
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To view the DGPS Status View screen:

1. Choose Messages | DGPS Status from the View menu.

The DGPS Status View screen is displayed.

Information Description

PRN Pseudo Random Noise code (SV identification) for the satellite.

Correction Current pseudo-range correction in meters.

Source Where the correction was received from. The options are external RTCM,
internal beacon, and WAAS.
If Internal Beacon is the DGPS source, the following information also
applies:

Locked: Status of tracking Coast Guard Beacon
Frequency: Frequency (KHz) of beacon tracked
Bit Rate: BPS for signal demodulation
Signal Magnitude: TBD
Signal Strength: TBD
SNR: Signal to Noise Ratio (TBD)
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4 The Action Menu

This section describes the SiRFdemo functions on the Action menu:

• "Opening a Data Source" on page 21

• "Opening a Log File" on page 22

• "To Pause the Display" on page 23

• "Initializing the Data Source" on page 23

• "Switching to the NMEA Protocol" on page 26

• "Switching to the SiRF Protocol" on page 28

• "Synchronizing Protocol and Baud Rate" on page 28

• "Switching to User1 Protocol" on page 28

• "Setting the Main Serial Port" on page 29

• "Setting the DGPS Serial Port Parameters" on page 29

• "Setting the UART Configuration" on page 30

• "Uploading an Almanac to the Evaluation Receiver" on page 31

• "Uploading an Ephemeris to the Evaluation Receiver" on page 32

• "Switching Operating Mode" on page 32

• "Setting Low Power Parameters" on page 34

• "Setting the Message Rate" on page 37

• "Transmitting a User Defined Serial Message" on page 38

Note - All values that appear in the dialog boxes under this menu are Evaluation
Receiver default values. To determine the current settings of all Navigation
Parameters, refer to page 49.
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ÿ Open Data Source (not connected)

ÿ Open Data Source (connected)

ÿ Open Log File

ÿ Pause Display

ÿ Initialize Data Source

4.1 Opening a Data Source

Before any data can be received from or sent to the Evaluation Receiver a communications
channel must be established or a data source must be opened.

To open a data source:

1. Click the Connect/Disconnect button or select Open Data Source from the Action
menu.

2. Click the Connect/Disconnect button again or select Open Data Source from the Action
menu to disconnect communication to the Evaluation Receiver.



22

4.2 Opening a Log File

The log file function provides the ability to log selected information from the Evaluation
Receiver to a named file.

To open a file and select messages to log:

1. Click the Log File Settings button or choose Open Log File from the Action menu. The
Log File Settings window is displayed.

2. Select each message you want to log to a file by clicking on the required message. You
can select all of the messages at once by clicking the Select All button.

Note - Only records that are selected will be logged to a file. If you are logging all
available messages, you should use a baud rate of 38400 or higher. This will ensure
that no data will be lost during logging.

3. Click OK to begin logging the selected messages or Cancel to abort opening a file.

Each of the available message types and a brief description is provided in table 4-7.

table 4-7 Messages That Can Be Logged to a File

Messages Description

002 Measured Navigation Time, position, velocity,...

004 Measured Tracking Satellite status and C/No

005 Raw Track Data Not supported by SiRFstarII

006 SW Version Software version of the Evaluation Kit

007 Clock Status Receiver clock performance
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table 4-7 Messages That Can Be Logged to a File

Messages Description

008 50 BPS Subframe Data Satellite ephemeris and almanac data

009 Throughput CPU throughput usage

010 Error Various error messages

011 Cmd Ack Acknowledgment of received commands

012 Cmd Nak Input message failures

013 Visible List Satellite visibility list (based on current almanac)

014 Almanac Satellite almanac data

015 Ephemeris Satellite ephemeris data

017 Raw DGPS Differential GPS corrections in RTCM format

019 Rcvr Params Parameters affecting navigation solutions

028 Navigation Measurements Observed satellite measurement data

029 DGPS Measurements Received differential GPS correction information

030 SV State Parameters Observed velocity, position and clock information

031 Startup Initialization Startup initialization information

255 Development Various development information

4.3 To Pause the Display

All of the open windows can be paused to allow easy viewing of the existing data without
receiving any further data.

To pause all of the open windows:

1. Click the Pause button or choose Pause Display from the Action menu.

Note - No data is logged while the display is paused.

4.4 Initializing the Data Source

You can reset or initialize the Evaluation Receiver directly through the SiRFdemo software.
This function may be used to demonstrate or evaluate the Evaluation Receiver's recovery
ability under different circumstances.
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To perform a receiver reset or allow Nav Lib or Development data to be output from the
Evaluation Receiver:

1. Click the reset button or choose Initialize Data Source from the Action menu.

The Receiver Initialization Setup screen is displayed.

2. Select type of Reset Mode by clicking on the associated radio button. Each of the reset
types are described in table 4-8.

table 4-8 Reset Types

Option Description

Hot Start The Evaluation Receiver restarts by using the values stored in
the internal memory of the Evaluation Receiver. The stored
ephemeris and almanac are both valid.

Warm Start (No Init) This option has the same functionality as Hot Start except that
it clears the ephemeris data and retains all other data.

Warm Start (Init) This option clears all initialization data in the Evaluation
Receiver and subsequently reloads the data that is currently
displayed in the Receiver Initialization Setup screen. The
almanac is retained but the ephemeris is cleared.
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table 4-8 Reset Types

Option Description

Cold Start This option clears all data that is currently stored in the internal
memory of the Evaluation Receiver including position, almanac,
ephemeris, and time. The stored clock drift however, is
retained.

Factory Start This option clears all data including position, almanac,
ephemeris, time, as well as the stored clock drift. All Evaluation
Receiver parameters are also set back to the factory defaults.

Note - If Cold start is selected, all Evaluation Receiver settings are reset to
factory defaults with the exception of low power settings.

3. If you selected the Warm Start (Init) reset mode, enter or load the X, Y, and Z
coordinates for the current position of the Evaluation Receiver. You can load a file
containing the X, Y, Z coordinates by clicking the Load button. The Specify a Name for
the Position File window is displayed.

4. Select the appropriate file.sample Sirf.pos configuration file.

Note - An example file called sirf.pos has been provided with the SiRFdemo
software. See "Modifying the Sample sirf.pos File" for more information on creating a
valid .pos file.

5. Click the OK button to accept or the Cancel button to exit.
The Receiver Initialization Setup screen is displayed again.

6. Type 96,000 in the Clock field (96,000 is a typical clock drift value of the crystal in the
Evaluation Receiver).

Note - If you type 0 in the Clock field, the Evaluation Receiver uses its last stored
value, or a default of 96,000 if no prior stored value is available.

7. Click on or off the Use current DOS time check box.
The default value is set to the current time.

Note - It is recommended that you use DOS time (it is assumed that the date and time
on your computer are set correctly).
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8. Type the number of the week in the Week Number field.

9. Type the time of the week in the Time of Week field.

10. Type number of channels in the Channel field.
You can specify from 1 to 12 channels.

11. Click on Enable Nav Lib Data to log navigation library data.

12. Click on Enable Development Data to turn on message 255. The content of this
message is displayed in the Development Data View. The baud rate of the SiRFdemo
software and the Evaluation Receiver is automatically changed to 57600 to ensure
sufficient through-put to accommodate the quantity of data.

Note - The Development Data output by the Evaluation Receiver is required to assist
in the analysis and debug of system performance problems. It is highly recommended
to enable Development Data during development and testing in the event of support
needs from SiRF.

13. Enter a periodic reset value in the Periodic Reset field to automatically reset the
receiver at the defined interval. Valid values are 5 to 600 seconds. A value of 0 (zero)
will cancel the periodic reset function.

14. Click the Send button to initialize or the Cancel button to exit.

4.5 Switching to the NMEA Protocol

The SiRFstarIIe/LP Evaluation Receiver supports a subset of the NMEA protocol. Rather
than operating in the SiRF binary protocol, you may change the protocol to NMEA for the
port that is currently connected.

Note - When operating in NMEA mode, many of the SiRFdemo display windows and
functions are not supported.
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To change the protocol to NMEA for the port currently connected to your PC:

1. Choose Switch to NMEA Protocol from the Action menu.

The Select NMEA Messages screen is displayed.

2. Select the NMEA Messages that you want to use by clicking on the required message.
Table 4-9 provides a brief description of each of the available NMEA messages. For
detailed information on the NMEA protocol, please see "NMEA Input/Output
Messages".

table 4-9 NMEA Messages

Option Description

GGA Time, position, and fix related data for a GPS receiver.

GLL Latitude and longitude of present position, time of position fix and
status.

GSA GPS receiver operating mode, satellites used in the position
solution, and DOP values.

GSV The number of GPS satellites in view satellite ID numbers,
elevation, azimuth, and SNR values.

RMC Time, date, position, course and speed data provided by the GPS
receiver.

VTG The actual course and speed relative to the ground.

MSS Signal-to-noise ratio, signal strength, frequency, and bit rate from a
radio-beacon receiver.

User 8 Reserved for a user defined NMEA string.

User 9 Reserved for a user defined NMEA string.

User 10 Reserved for a user defined NMEA string.
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3. Select the update rate for each NMEA message that you want to use from the
corresponding Update Rate pulldown menu. Each NMEA message can be output at a
maximum rate of 1 per second and at a minimum rate of 1 per 255 seconds.

4. Select the baud rate that you want to use from the Baud Rate pull down menu.

5. Click the OK button to save or the Cancel button to exit.

Note - When the Evaluation Receiver is selected to operate using the NMEA protocol,
the output messages can be viewed in the Development Data screen. It can also be
logged by using the same technique as a SiRF binary file. Select 255-Development in
the Log File Settings screen and Enable Development Data must be checked in the
Messages field of the Receiver Initialization screen.

4.6 Switching to the SiRF Protocol

If you are already operating using the SiRF binary protocol, this menu item is unavailable. It
can be used, however, with the NMEA protocol and if you want to change the operating
protocol back to the SiRF binary protocol.

To change the operating protocol from NMEA to SiRF binary:

1. Choose Switch to SiRF Protocol from the Action menu to return to the SiRF binary
protocol.

4.7 Synchronizing Protocol and Baud Rate

All Evaluation Receiver settings including selected protocol and serial port settings are held
in battery backed SRAM. If the Evaluation Receiver is power cycled, these settings will
remain. If the Evaluation Receiver is left in an unknown state, it is difficult to regain
communication with it.

The synchronize protocol and baud rate function attempts to change the serial port settings
of the Evaluation Receiver to a known state of SiRF binary and 38400 baud. This is done by
issuing commands to the receiver using all possible baud rates and both NMEA and SiRF
binary protocols. After this is complete, SiRFdemo resumes operation using SiRF binary
protocol and 38400 baud. As the receiver should also be operating with the same settings at
this time, communication is resumed.

4.8 Switching to User1 Protocol

If a user protocol has been defined and implemented in the version of software running,
Switch to User 1 menu item can be used to enable the user defined protocol.
If Switch to User 1 is selected, the target platform changes to the user defined protocol, but
SiRFdemo continues to operate in SiRF Binary.

Note - If the target platform is operating in the user defined protocol, there is no direct
method through SiRFdemo to switch the target platform back to SiRF Binary. An
application based on the user protocol must be used, or the Send Serial Message
ability may be utilized.

To change the operating protocol to a user defined protocol:

1. Choose Switch to User 1 Protocol from the Action menu.
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4.9 Setting the Main Serial Port

The Set Main Serial Port function lets you change the baud rate of the serial port connected
to the Evaluation Receiver and the serial port of the PC.

To change the baud rate of the port used by the Evaluation Receiver and the PC:

1. Choose Set Main Serial Port from the Action menu.

The Set Serial Port Parameters screen is displayed.

2. Select the baud rate you want to use.

3. Click the Send button to accept or the Cancel button to exit.

Clicking the Send button resets the Evaluation Receiver and computer's serial port to
start communicating using the new baud rate.

4.10 Setting the DGPS Serial Port Parameters

The Set DGPS Serial Port Parameters function will configure the second serial port (the
serial port not currently used by the SiRFdemo software) of the Evaluation Receiver for
reception of RTCM data.

To configure the available port for RTCM reception:

1. Choose Set DGPS Serial Port from the Action menu.

The Set DGPS Serial Port Parameters screen is displayed.

2. Select the baud rate, data bits, parity, and stop bits that you want to use for the DGPS
serial port parameters from each pull down menu.
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3. Click the Send button to accept or the Cancel button to exit.

Clicking the Send button resets the Evaluation Receiver and changes the protocol of
the second port to RTCM and the serial port settings to the selected values.

Note - The differential correction data source must be configured separately. See
"Defining the Data Source" on page 7.

4.11 Setting the UART Configuration

The UART configuration control is provided to allow support of four unique UARTS. You can
configure UART settings such as protocol, baud rate, data bits, parity, and stop bits using
the UART configuration control.

Four UART support is provided by some SiRF products, but it is not supported by the
SiRFstarIIe/LP Evaluation Receiver. The Evaluation Receiver is restricted to two UARTs (or
serial ports) only. The UART configuration control is provided primarily for system
developers.

To set the UART configuration of the Evaluation Receiver for the two supported UARTs:

1. Choose Set UART Configuration from the Action menu.

The UART Configuration screen is displayed.
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Note - The com ports supported in a standard Evaluation Receiver are UART 0 (CPU
SCIO 0, COM port A) and UART 1 (CPU SCIO 1, COM B).

2. Check the Set box for each UART you want to apply changes to.

If the Set box is not checked, the existing configuration remains in its current state.

Note - UART 0 is equivalent to com port A of the Evaluation Receiver, and UART 1 is
equivalent to com port B.

3. Select SiRF binary, NMEA, RTCM, or No I/O from the Protocol selection list.

Select No I/O from the Protocol pull down menu to disable the data output from any
port. Each protocol can only be supported by one UART. You cannot configure two
different ports to use the same protocol.

4. Select the appropriate serial communication parameters using the selection lists for
baud rate, data bits, parity, and stop bits.

5. Click the Send button to accept or the Cancel button to exit.

4.12 Uploading an Almanac to the Evaluation Receiver

An almanac file is used by a GPS receiver to assist with locating and tracking available
satellites. If a current almanac file does not exist in the Evaluation Receiver due to a cold
start or if it has not been used for a long period of time, loading a recent almanac file will
assist the Evaluation Receiver in locating and tracking satellites.

To upload an almanac file to the Evaluation Receiver:

1. Choose Set Almanac from the Action menu.

The Specify Almanac Data Filename To Load screen is displayed.

2. Specify the file you want to use.

3. Click the OK button to accept or the Cancel button to exit.



32

Note - The almanac file must be in the same format as polled from the Evaluation
Receiver. To download an almanac file from the Evaluation Receiver, see
"Downloading an Almanac File" on page 50.

4.13 Uploading an Ephemeris to the Evaluation Receiver

An ephemeris is used by a GPS receiver to calculate the position of the satellites and hence,
the position of the GPS receiver. If an ephemeris file is not available, then this must be
downloaded from a GPS satellite. To eliminate the time required to download this
information from the GPS constellation, a current ephemeris file can be uploaded to the
Evaluation Receiver using the SiRFdemo software.

To upload an ephemeris file to the Evaluation Receiver:

1. Choose Set Ephemeris from the Action menu.

The Specify Ephemeris Data Filename To Load screen is displayed.

2. Specify the file you want to use.

3. Click the OK button to accept or the Cancel button to exit.

Note - The ephemeris file must be in the same format as polled from the Evaluation
Receiver. To download an ephemeris file from the Evaluation Receiver, see
"Downloading an Ephemeris File" on page 51.

4.14 Switching Operating Mode

It is possible to place the Evaluation Receiver into a test operating mode. This mode allows
a single selected satellite to be tracked by all 12 channels of the Evaluation Receiver.
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To place the Evaluation Receiver into test mode:

1. Choose Switch Operating Mode from the Action menu.

The Switch Operating Mode screen is displayed.

2. Select Test 1 or Test 2 if you want to track a specific satellite on all channels and output
test results. Test 2 outputs additional data to that of Test 1.

Note - Test 1 and Test 2 enables Testmode 1 and Testmode 2 data respectively. For a
full description of each testmode, please see section , "Test Mode 1 - Message I.D.
16," on page 47 and section , "Test Mode 2 - Message I.D. 20," on page 50.

3. In the Period field, enter the output rate of the test reports in seconds.

4. Enter the SV number that you want to be tracked by all 12 channels of the Evaluation
Receiver.

5. Select Normal (default) to track all available satellites.

6. Send the command to the Evaluation Receiver by clicking the SEND button.

When the Evaluation Receiver is changed to a test mode, every channel on the
receiver tracks only the satellite specified by the user. This can be confirmed by viewing
the 12-Channel Signal Level view as shown in figure 4-1 on page 33.
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figure 4-1 12-Channel Signal Level View Window when the Evaluation Receiver is in a Test
Mode

4.15 Setting Low Power Parameters

The SiRFstarIIe/LP Evaluation Receiver can operate in three modes (shown in table 4-10).

table 4-10 Evaluation Receiver Modes

Mode Description

Full Power Full power mode is the standard operating mode. Power is supplied
to the receiver continuously and the Evaluation Receiver continues
to operate without an interrupt.

TricklePower In TricklePower mode, the power to the SiRF chipset is cycled
periodically, so that it operates only a fraction of the time. Power is
applied only when a position fix is scheduled.

Push-to-Fix In Push-to-Fix mode, the Evaluation Receiver is generally off, but
turns on frequently enough to collect ephemeris data to maintain the
GSP1 real time clock calibration so that, upon user request, a
position fix can be provided quickly after power-up.

TricklePower

In this mode, the power to the GRF2i/LP chip is cycled regularly, according to two user-
specified parameters:

• Update Rate
• OnTime
• Maximum Off Time
• Maximum Search Time

During TricklePower operation, the GRF2i/LP chip is powered on for OnTime (in
milliseconds), then powered off for a specified number of milliseconds as determined by the
update rate. This cycle repeats indefinitely.
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The GSP2e/LP chip is not explicitly powered down, but its primary operation is driven by the
GPS clock generated by the GRF2i/LP, so it draws very little power while the GRF2i/LP is
powered down. The real time clock (RTC) portion of the GSP2e/LP continues operation at
all times, and is used to generate the interrupt that turns everything back on.

The microprocessor on which the SiRF code executes is not explicitly powered down. After
the OnPeriod has elapsed, the processor continues operating long enough to complete its
navigation tasks, then puts itself in sleep mode until it is reawakened by the RTC-generated
wake up interrupt.

The default parameter values are:

• Update Rate = 1 second
• On Time = 200 ms
• Maximum Off Time = 30000 ms
• Maximum Search Time = 120000 ms

Push-to-Fix

For applications where a position fix is required on demand (that is, not continuous) then the
Push-to-Fix mode is the most appropriate mode of operation for power sensitive situations.
In this mode, the receiver turns on periodically according to the user specified parameter:

Push-To-Fix Period

When the receiver turns on, the ephemeris records are updated and the clocks calibrated.
When all internal updating tasks are complete, the receiver powers itself off (except for RTC)
and schedules the next wake up period.

The default parameter is:

Push -To-Fix Period = 1800 seconds

When the Evaluation Receiver is power cycled externally, a navigation solution will be
available to the user in 3 seconds.



36

To set the Evaluation Receiver trickle power mode:

1. Select Set Trickle Power Parameters from the Action menu.

The Trick Power Parameters screen is displayed.

2. Select the required operating mode.

3. If Trickle Power is selected then you must enter an Update Rate, an On Time,
Maximum Off Time, and Maximum Search Time.

4. Click Send to activate selection.

Table 4-11 shows the Update Rate and On Time combinations that the Evaluation Receiver
supports when in trickle power.

table 4-11 Trickle Power: Update Rate and On Time

Update Rates (seconds)

On Time (ms) 1 2 3 4 5 6 7 8 9 10

200 � � � � � � � � � �

300 � � � � � � � � � �

400 � � � � � � � � � �

500 � � � � � � � � � �

600 � � � � � � � � � �

700 � � � � � � � � �

800 � � � � � � � � �

900 � � � � � � � � �
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To conserve power at start up, you can control how long (Maximum Search Time) the
system should attempt to acquire satellites and navigate, and how long (Maximum Off Time)
the Evaluation Receiver should remain off (sleep mode) before making another attempt to
navigate. Maximum times are in ms.

Example: Maximum Off Time 30000 ms (default)
Maximum Search Time 120000 ms (default)

Scenario 1: System is turned on, but does not acquire Svs (no antenna connected).

Result: System searches for 120000 ms, sleeps for 30000 ms, searches again for
120000 ms, etc.

Scenario 2: System is turned on and acquires Svs, but does not navigate.

Result: System searches for 120000 ms, sleeps for 30000ms, searches again for
120000 ms, etc.

Scenario 3: System is turned on, acquires and navigates.

Result: Sleep mode is disabled.

4.16 Setting the Message Rate

You can configure each SiRF binary output message so it is output using a specified
frequency.

To set the SiRF binary output rates:

1. Choose Set Message Rate from the Action Menu.

The Set Message Rate screen is displayed.

2. Select the appropriate SiRF binary message from the Select Message selection list.

3. Enter in the rate at which you want the selected SiRF binary message to be output.

Note - The message rate is based on navigation cycles, not seconds. For example, in
Trickle Power mode at an update rate of 2 seconds, selecting 5 as the message
output rate outputs the selected message every 10 seconds. 10 seconds, in this case,
is equivalent to 5 navigation cycles. An Update Rate of 0 will disable the output of that
message.
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The decrement of the navigation cycle counters for each message begins when the
Evaluation Receiver accepts and verifies the input command. Each message is done
separately and no mechanism is currently in place to synchronize message output. Message
counters are stored in DRAM so they are preserved over hot and warm software resets but
will revert to defaults values over power cycles, cold, and factory resets.

4.17 Transmitting a User Defined Serial Message

The Transmit Serial Message function provides the ability for a user to send generic serial
messages to the attached target platform. The message can be automatically wrapped with
SiRF Binary or NMEA information or transmitted as is.

To transmit a user defined message to the target platform:

1. Select Transmit Serial Message from the Action menu.

The Send Data screen is displayed.

2. Type the payload of the message that you wish to send to the target platform in the free
text field.

Hex format should be used for a binary message content or ASCII for intended NMEA
messages.

Note - The defined message can be saved in a CMD file by clicking on the SAVE
button and specifying a file name. An already defined message that has been saved
can be loaded by clicking on the LOAD button and selecting the appropriate file.

3. Select the desired protocol wrapper from the Protocol Wrapper options. Each of the
options are described in table 4-12 on page 39.
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table 4-12 Protocol Wrapper Modes

Option Description Default

SiRF Binary The payload of the message will be converted to On
binary with the appropriate SiRF Binary start
sequence, payload length, message checksum,
and end sequence will be calculated and added
to the payload.

NMEA The appropriate NMEA format start sequence, Off (8)
message checksum, and end sequence will be
calculated and added to the payload.

None No protocol wrapper of any type will be added to Off (8)
the defined payload.

4. Send the defined message to the target platform by clicking the SEND button.

5 The Navigation Menu

This section describes the SiRFdemo software functions under the Navigation menu:

• "Setting Navigation Mode Control" on page 39

• "Setting the DOP Mask Control" on page 42

• "Setting the DGPS Mode" on page 43

• "Selecting the DGPS Source" on page 44

• "Selecting an Elevation Mask" on page 45

• "Selecting a Power Mask" on page 46

• "To Enable/Disable the Static Navigation" on page 46

5.1 Setting Navigation Mode Control

Navigation mode control is used to configure the specifics of how the Evaluation Receiver is
to navigate or calculate a position. In particular, selecting how a position should be derived if
a minimum number of satellites are not available to calculate a full 3D position.
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To set the navigation mode control:

1. Choose Mode Control from the Navigation menu.

The Navigation Mode Control screen is displayed.

2. Select the required options. Table 4-13 describes each of the navigation mode options
available.

table 4-13 Navigation Mode Options

Option Description Default

Enable Track Enables smoothing of the calculated positions Off
Smoothing based on acceptable variances from the last

calculated position. This assists in eliminating
any sporadic position jumps possibly caused
by multipath, for example.

Enable Altitude Restrict any variations in the altitude to 10% of On
Constraint currently calculated horizontal variation. This

assists in creating a smoother ground track.
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table 4-13 Navigation Mode Options

Option Description Default

Altitude Hold Mode

Automatic Switch automatically to a 2D solution and hold On
the altitude fixed if only three satellites are
available. A 3D solution will be calculated if four
or more satellites are available.

Always Stay in 2D mode regardless of the number of Off
satellites available. The altitude will always
remain fixed.

Disable Altitude Only calculate 3D solutions. If it is not possible Off
Hold to calculate a 3D solution due to insufficient

satellites, then no navigation will be provided.

Last Computed If the Evaluation Receiver is operating in 2D Off
Altitude mode, then the altitude will be held to the last

known altitude calculated by the Evaluation
Receiver.

Fixed to If the Evaluation Receiver is operating in 2D Off
mode, then the altitude will be held to the value
entered in the FIXED TO field.

Degraded Modes

Use Direction then If the number of available satellites is reduced Off
Clock Hold to two, the Evaluation Receiver will hold the

elevation fixed, and use the last direction and
doppler values (change in distance) to continue
positioning. If the available satellites is then
reduced to one, the clock bias is then extrapolated.

Use Clock then This mode is similar to the above Direction then On
Direction Hold Clock Hold mode. However, the clock bias is

extrapolated first, and then the direction and
doppler measurements are used.

Direction (Curb) This mode will restrict positioning to using direction Off
Hold Only hold only and does not use the extrapolating the

clock bias method. Two satellites need to be
available.

Clock (Time) Positioning is restricted to using the clock bias Off
Hold Only extrapolation method only and does not hold the

direction. Two satellites need to be available.

Disable Degraded If less than three satellites are available, no Off
Modes position will be calculated.

Timeout The Evaluation Receiver will only operate in any 60
degraded mode for the period of time specified
by the timeout.
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table 4-13 Navigation Mode Options

Option Description Default

Dead Reckoning

Enable Dead If a position solution is not possible due to On
Reckoning Mode insufficient satellites, a positions will be calculated

using the last known velocity. Only applies if the
Evaluation Receiver is being used in a dynamic
environment.

Timeout The Evaluation Receiver will only calculate positions 15
using dead reckoning for the period of time specified
by the timeout.

3. Click the Send button to accept or the Cancel button to exit.

5.2 Setting the DOP Mask Control

This mask enables you to control the position output of the Evaluation Receiver so that
positions computed with a high DOP value are not output. When the DOP mask is
exceeded, the position message status changes to DOP mask exceeded and the position
does not update.

To set the DOP mask controls:

1. Choose DOP Mask Control from the Navigation menu.

The DOP Mask Control screen is displayed.
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2. Select the Mode that you want to use.

Option Description Default

Auto PDOP/HDOP The PDOP mask will be used if four or more Off
satellites are available. If only three satellites
are available, the HDOP mask will be used.

Use PDOP only Only the PDOP mask will be used regardless Off (8)
of the number of satellites available.

Use HDOP only Only the HDOP mask will be used regardless Off (8)
of the number of satellites available.

Use GDOP only Only the GDOP mask will be used regardless Off (8)
of the number of satellites available.

Do not use No DOP based mask will be applied. Any On
available position will be output regardless of
any of the DOP values.

3. Enter a DOP mask value for the corresponding selected DOP mask.

For each of the DOP masks, the default value is 10. This value is a maximum value
and the mask will apply if the current set mask is exceeded.

4. Click the Send button to accept or the Cancel button to exit.

5.3 Setting the DGPS Mode

The DGPS mode is used to control the position output of the Evaluation Receiver based on
whether positions are differentially corrected or not. The options include automatic,
exclusive, and never use.

To set the DGPS mode:

1. Choose DGPS Mode from the Navigation menu.

The DGPS Control screen is displayed.
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2. Select the Mode that you want to use.

Option Description Default

Automatic Use differential corrections when they are On
available, otherwise compute a non differential
solution. (see note below)

Exclusive Only compute a differential solution. If no Off
corrections are available no solution is output.

Never use Only compute a non differential solution Off
(even if corrections are valid).

3. Enter the timeout value (in seconds) you want to use in the Timeout field.

A received differential correction will be applied to the solution until either the timeout
value is exceeded, or a new differential correction is received.

4. Click the Send button to accept or the Cancel button to exit.

Note - For a differential position to be calculated, a pseudorange correction must be
valid for each satellite being tracked by the Evaluation Receiver. If the there are less
corrections than tracked satellites, then a non-differential position will result. If
corrections exist for different satellites to that being tracked by the Evaluation
Receiver, then a non-differential position will result.

5.4 Selecting the DGPS Source

The SiRFstarIIe/LP Evaluation Receiver has the ability to receive RTCM differential
corrections from different sources. The DGPS source control is used to select which source
will be used to obtain RTCM differential corrections.

To select the DGPS source:

1. Choose DGPS Source from the Navigation menu.

The DGPS Source screen is displayed.
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2. Select the Source that you want to use. Table 4-14 describes each of the available
DGPS sources.

table 4-14 DGPS Sources

Option Description Default

None The Evaluation Receiver will not use any of No
the available DGPS sources.

WAAS Channel The Evaluation Receiver will use the WAAS No
correction service if available. One of the twelve
channels will be dedicated to the WAAS signal.

External RTCM The Evaluation Receiver will use any RTCM Yes
Data corrections that are input directly through one

of the serial ports.

Internal DGPS The internal beacon receiver will be used to No
Beacon Receiver provide RTCM corrections received from an

operating radio-beacon. A beacon antenna is
required.

3. If the Internal DGPS Beacon Receiver is the chosen DGPS source, select the auto
scan options. The auto scan options are described in table 4-15.

table 4-15 Auto Scan Options

Auto Search Description

Frequency The internal beacon receiver will automatically scan the radio-
beacon frequency range until a usable signal is acquired. If this
option is deselected, you must enter a signal frequency for the
beacon receiver to use.

Bit Rate Radio-beacons may broadcast the correction information using
different bit rates (the number of bits of data per second). If this
option is selected, the internal beacon receiver will also search the
different available bit rates until a usable signal is acquired. If this
option is deselected, you must enter a signal bit rate for the beacon
receiver to use.

Note - The SiRFstarIIe/LP Evaluation Receiver does not support the Internal DGPS
Beacon Receiver option.

4. Click the OK button to accept or the Cancel button to exit.

Note - The selection made in the DGPS Source screen is displayed in the DGPS
Status View screen by selecting View | Messages | DGPS Status.

5.5 Selecting an Elevation Mask

GPS satellites that are low on the horizon are subject to noise due to the amount of
atmosphere that the signal must travel through. Better position accuracy is often achieved if
lower elevation satellites are not used in the position solution. The elevation mask is used to
exclude the use of satellites in the position solution that are below a defined elevation mask.
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To select an elevation mask:

1. Choose Elevation Mask from the Navigation menu.

The Elevation Mask screen is displayed.

2. Enter the minimum elevation angle for satellites to be used in any position solution.

3. Click the Send button to accept or the Cancel button to exit.

5.6 Selecting a Power Mask

GPS satellites that have a low signal strength are not easily tracked by the Evaluation
Receiver and may result in using signals that are either noisy or have been effected by
multipath or other interference source. To increase accuracy, it may be necessary to
exclude GPS satellites with a signal strength below a selected value.

To exclude satellites from the position solution with a signal strength below a selected value:

1. Choose Power Mask from the Navigation menu.

The Power Mask screen is displayed.

2. Enter the minimum satellite signal level for satellites to be used in any position solution.

3. Click the Send button to accept or the Cancel button to exit.

5.7 To Enable/Disable the Static Navigation

The steady state detection allows the navigating algorithms to decrease the noise in the
position output when the acceleration is below the threshold. This reduces the position
wander caused by Selective Availability (SA) and improves position accuracy especially in
stationary applications.
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To select the static navigation mode:

1. Choose Static Navigation from the Navigation menu.

The Static Navigation screen is displayed.

2. Select the option that you want to use.

Option Description Default

Disable Displays true user movement due to Selective Yes
Availability (and other environmental issues such
as multipath).

Enable Holds the current position as fixed when the user is No
in a stationary mode. Updates to the fixed position
due to Selective Availability are made based on
internal navigation data.

3. Click the Send button to accept or the Cancel button to exit.

Note - The Static Navigation filter is Disabled when DGPS corrections are used in the
navigation solution.

6 The Poll Menu

This section describes the SiRFdemo software functions under the Poll menu:

• "The Software Version" on page 48

• "The Clock Status" on page 48

• "The Navigation Parameters" on page 49

• "Downloading an Almanac File" on page 50

• "Downloading an Ephemeris File" on page 51
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6.1 The Software Version

The poll software version function allows you to query the Evaluation Receiver for the
version of embedded software currently being run.

To view the current software version:

1. Choose SW Version from the Poll menu

The Response View screen is displayed showing the software version currently
being run.

6.2 The Clock Status

The poll clock status function allows you to query the Evaluation Receiver for clock
performance information including the GPS week number, GPS time, clock drift, and clock
bias.

To poll the Evaluation Receiver for clock status information:

1. Choose Clock Status from the Poll menu.

The Response View screen is displayed with the clock status.
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A description of each of the clock status items are given in table 4-16.

table 4-16 Clock Status Items

Item Description

Week The number of continuous weeks that GPS has been operational.
The start date being January 6, 1980.

TOW Time of Week � the number of GPS seconds since the start of the
current GPS week. The start of the GPS week being 0 hrs Sunday
UTC.

EstGPS Time The estimated TOW while the Evaluation Receiver is not tracking
GPS satellites.

SVCnt The number of satellites currently being tracked and used in the
position solution.

Clock Drift The change in the clock bias. A typical range would be between
76 kHz and 116 kHz.

Clock Bias The offset of the Evaluation Receiver clock compared with the
current GPS time.

6.3 The Navigation Parameters

All of the user settings that have been set under the Action and Navigation menus can be
polled for their current status and settings.

To poll the Evaluation Receiver for it's current navigation parameters:

1. Select Navigation Parameters from the Poll menu.

The current settings are displayed in the Response View window.

A description of each of the navigation parameters are given in table 4-17.

table 4-17 Navigation Parameters

Parameter Description

AltMode The selected altitude hold mode.

AltSource The altitude type used when a 2D solution is being calculated.

Altitude The altitude used if fixed manually.

DegradeMode The type of degraded mode selected.

DegradedTimeout The timeout value applied to degraded mode operation.
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table 4-17 Navigation Parameters

Parameter Description

DR Timeout The timeout value applied to dead reckoning navigation.

TrkSmoothMode The enable or disable state of track smoothing.

StaticNav The enable or disable state of the static navigation mode.

3SV LSQ Indicates the state of a start-up mode that will allow start-up when
only three satellites are available.

DOPMaskMode The selected DOP mask control.

ElevMask The currently used elevation mask.

PwrMask The currently used power mask.

DGPSSrc The selected DGPS source.

DGPSMode The selected DGPS mode.

DGPSTimeout The timeout value applied to DGPS corrections.

Power Mode This line indicates the current power mode of the Evaluation
Receiver. It will be either trickle power or full power.

MaxAcqTime The Maximum Acquisition Time.

MaxOffTime The Maximum Off Time.

6.4 Downloading an Almanac File

You can download an almanac file from the Evaluation Receiver and load it back into the
receiver at a later date or to another Evaluation Receiver. This is to assist with initial satellite
tracking. This file may also be used for mission planning and constellation investigations.

To download an almanac file:

1. Choose Almanac from the Poll menu.

The Specify Almanac Data Filename To Load screen is displayed.
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2. Specify the file name in which to save the almanac information.

3. Click the OK button to save or the Cancel button to exit.

Clicking the OK button saves the data to file. A message box is displayed to confirm
completion.

To load an almanac file, see "Uploading an Almanac to the Evaluation Receiver" on page
31.

6.5 Downloading an Ephemeris File

You can download an ephemeris file from the Evaluation Receiver and load it back into the
receiver at a later date or to another Evaluation Receiver. This is to assist with initial position
calculations. This file may also be used for mission planning and constellation investigations.
To download an ephemeris file:

1. Choose Ephemeris from the Poll menu.

The Specify Ephemeris Data Filename To Load screen is displayed.

2. Specify the file name that you want to save the ephemeris information to.

3. Click the OK button to save or the Cancel button to exit.

Clicking the OK button saves the data to file. A message box is displayed to confirm
completion.

To load an ephemeris file, see "Uploading an Ephemeris to the Evaluation Receiver" on
page 32.


